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Introduction 

Car Manager is a desktop application that serves two primary purposes.  It is an administrative tool used 

for user management and system settings. It is also a portal for monitoring, editing, and managing your 

Equipment and Component data.  For more information refer to the sections on Component Association 

and Component Registration.   

Car Manager is intended for use by Managers, Quality Assurance personnel, and office administrators.  

In most cases it is a supplement to other components of the Railcar Integrated Maintenance Suite 

(RIMS) installed on the production floor or shop/yard.  For more information about our other RIMS 

components please visit our website at www.wheelshopautomation.com or contact us. 

Car Manager requires access to an instance of the RIMS database which can be installed on the same 

computer or any computer with network access and the required permissions.  In most cases a 

computer running our RIMS Service is also required.  Refer to the Initial Setup for more information 

 

 

  

http://www.wheelshopautomation.com/
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System Requirements 

This application has minimum system requirements as described below. These requirements must be 

met in order for the application to operate as designed.  

This application supports the following Microsoft Windows operating systems. 

 Windows Vista SP2 (x86 and x64) 
 Windows 7 SP1 (x86 and x64) 
 Windows Server 2008 R2 SP1 (x64) 
 Windows Server 2008 SP2 (x86 and x64) 

The application requires the Microsoft .Net Framework 4.5 Full which can be obtained from Microsoft at 
http://www.microsoft.com/en-us/download/details.aspx?id=30653 

The application requires the following hardware at a minimum.  

 2.0 GHz Processor  
 1 GB installed RAM  
 100 MB available disk space  
 Ethernet Card  

   

http://www.microsoft.com/en-us/download/details.aspx?id=30653
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Getting Started 

Installing Car Manager 

You will need Administrator rights to install Car Manager. 

Make sure you have the latest version of our Car Manager Setup program.  Contact our support team 

for assistance.  To install Car Manager, run the setup program and follow the on screen prompts as 

described below: 

Click Next to continue. 
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Accept the license agreement and click Next. 

 

 

Select the location where you would like to install Car Manager to and click Next. 
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Click Install to begin the installation. 

 

 

When the installation has completed, click Finish to close the setup application. 
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Initial Setup 

Once you have installed Car Manager you can double click the desktop shortcut to start the application. 

Database Connection Settings 

Car Manager requires access to an instance of the RIMS database which can be installed on the same 

computer or any computer with network access and the required permissions.  The first time you run 

Car Manager you will be prompted to enter your database connection settings.  

Click OK to display the Connection Settings dialog. 

 

 

Click Configure. 
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Enter the connection settings for the server where the RIMS database is located.  If you are unsure 

contact your IT Department or our support team. 

Click Test Connection to verify your settings. 

Click OK when you are finished. 
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Click the Shop Name drop down to select the location for which you want to configure this installation.  

RIMS can support multiple locations or ‘shops’ hosted in one database.  In order to isolate the data and 

settings to your location you must provide this information. 

After you have selected the Shop Name click on Machine Name and select the machine you are 

installing on.  Some settings are stored per machine so this setting will be used to differentiate each 

installation.  

 

Click Save to save your changes.  

Once you have entered your database settings you will be prompted to log on.  You must have an 

existing user name and password in the RIMS system.  If you do not have this information, contact your 

manager or a system administrator.  See the following section regarding Log on for more information. 
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RIMS Service settings 

The final configuration step is to enter the RIMS Service endpoint.  RIMS Service is a web service 

endpoint used by components in the RIMS system including Car Manager.  It enables Car Manager to 

submit component associations, component registrations, and queries to Railinc via their web services 

endpoint.   

To enter the RIMS Service endpoint settings click on Tools->Options. 

 

Enter the computer name or network address of the computer hosting the RIMS Service application in 

the Host box. 

The Port is the HTTP port number on your computer.  This allows the RIMS Service to send response 

information back to Car Manager.  The default port is 80.  If you are having problems connecting to the 

RIMS Service you may need to use a different port number.  Contact your IT department or our support 

team if you need assistance. 

In some cases you may want to disable Association or Registration features on a computer.  Disabling 

these features will not disable any data viewing or editing; it will only disable the communication 

between this instance of Car Manager and the RIMS Services. 

Click Save to save your changes. 

  

http://www.railinc.com/
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Log on / Log off 

Each user is given a unique user name and password for the RIMS system for authentication and 

accountability.  You must provide your user name and password each time Car Manager starts before 

you can begin.  Your log on also determines what functions you have permissions to perform.  For more 

information about permissions and users refer to the next section on Users and Groups. 

 

 

To log off the current user select Log off from the File menu.  
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Users and Groups 

Managing Groups 

Groups determine the permissions granted to each user.  You can create as many groups as required. 

Each group can be assigned a different combination of permissions.  For example, you may want User 1 

to have view only access but User 2 needs permission to create equipment.  To accomplish this you can 

create a ‘view only users’ group that does not have any permissions.  Assigning User 1 to this group will 

allow them to log in and view/search equipment but they won’t be able to make any changes.  Creating 

a second group with the ‘CreateEquipment’ permission and assign User 2 to that group will allow them 

to add new equipment. 

Select Manage Groups from the Tools menu to add/modify groups and set the permissions for each 

group. 

 

Select a group from the left side to edit the permissions for an existing group. 

Click Add to create a new group. 

Click Copy to make a copy of the selected group and give it a new name.  This is useful if you want to 

create a new group with just one or two different permissions from the group you are copying. 
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Click Delete to delete the currently selected group. You will be prompted to confirm that you want to 

delete. Click Yes to delete the group. 

 

If creating a new group/copying an existing group, enter a name for the group in the Name box.  If you 

are editing an existing group this box cannot be edited.   

Check the box next to the permission name to allow the selected group to perform that function.  

Uncheck the box to remove the permission from the currently selected group. To assign all permissions 

you can click the ‘Select All’ checkbox. To remove all permissions click the ‘Select All’ checkbox a second 

time. 

Click Save to apply any changes or save a new group. 

Click Cancel to undo any changes. 

Click Ok to close the Manage Groups dialog. 
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Managing Users 

Each user should be assigned a unique user name and password for authentication and accountability.  

Any changes are logged and tracked to the user name of the currently logged on user. It also helps to 

ensure certain functions can only be performed by trained and qualified persons. 

Select Manage Users from the Tools menu to add/modify users. 

Select an existing user from the list on the left to edit an existing user. 

Click Add to create a new user. 

Click delete to remove the currently selected user. 

If creating a new user, you can assign the user name in the Name box.  If editing an existing user the 

Name cannot be edited. 

The Full Name box allows you to enter the first and last name of the user.  This field is optional. 

The Description box allows you to enter any other information that may pertain to the user.  This could 

be something like the user’s job title, department, or employee ID.  This field is optional.  

The Set Password button allows you to change the user’s password.  When creating a new user the 

default password is left blank.  Once the user has been saved the password can be set using the Set 

Password button. 
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When checked, the ‘Require user to change Password on next login’ checkbox sets a field in the user’s 

account that will require them to change their password the next time they log on to any RIMS 

application.  After they log on using their current user name and password they will be prompted to 

enter a new password and will not be allowed to continue until they have done so. This field is 

automatically disabled once the user has changed their password. 

The ‘Account is disabled’ checkbox determines whether or not the user can log on to any RIMS system.  

When checked the user will be blocked from logging on to any RIMS application. 

Once you have filled in the new user’s information, select the Permissions tab next to User Info. 

 

This tab lets you select which shops the new user will be able to access.  The Group determines which 

permissions group the user belongs to for each shop.  Refer to the section above on Managing Groups 

for more information about groups and permissions.  Leaving this box blank indicates that the user does 

not have permission to access the associated shop. 

Finally, use the checkboxes to select the user’s default shop. A user’s default shop does not affect the 

permissions granted for any shop; it only determines which shop the user logs into (regardless of the 

shop chosen in Database Connection Settings) when Car Manager is started.  NOTE: A default shop must 

be selected in order to save the new user information. 

Click Save to save your changes to the user. 

Click Cancel to undo any changes. 

Click Ok to close the Manage Users dialog. 
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Reports 

 

The Reports tab shows all the reports stored on the database, which can be in separate categories. 

Selecting one of the reports will bring it up into a separate Report Viewer window. To remove a report 

from Car Manager, click on the red ‘X’ beside the report you want to remove. If there are no reports 

under the tab, some must be uploaded to the database from the desktop using the import feature. 

 

The import feature uploads reports files from the host computer onto the database, using the 

information provided. 

 File Path – The location on the hard drive of the report file to be uploaded. 

 Report Name – The name to store the report under in the database. 

 Category – An optional value to give each report in order to sort them when they are uploaded. 

 Description – Reserved for future use. 

 Version – Reserved for future use. 

When viewing reports, you can export the current report from the database to the desktop either in 

Excel, PDF, or Word format. 
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Component Association 

Overview 

One of the roles of Car Manager is to assist with Component Association as required by the AAR’s 

Comprehensive Equipment Performance Monitoring (CEPM) program.  This program tracks the 

application of Wheelsets, Side Frames 1, Bolsters 1 , and Couplers 1 to the equipment. 

For more information refer to the CEPM Program Overview at   

https://www.railinc.com/rportal/cepm-project-overview  

 

  

                                                           
1
 Required in 2014 

https://www.railinc.com/rportal/cepm-project-overview
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Repair History 
 

Once you have selected an equipment from the list, you can view the equipment’s repair history by 

clicking the ‘Repair History’ button in the details pane. 

 

The Repair History window displays all repairs for the current equipment in the left pane.  Select a repair 

to view the modifications to the equipment specific to that repair. 
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Managing Equipment Types 

The first step in tracking equipment and components is to identify the different types of equipment.  

The equipment types determine the number of component locations based on the number of trucks. 

This allows for the RIMS system to work with all forms of articulated and non-articulated equipment. 

To create a new equipment type, click on the Equipment menu and select ‘Add Equipment Type’. 

 

The equipment type Name can be as generic as ‘Coal Car’, ‘Box Car’, ‘Hopper’, or as specific as part 

numbers.  Enter the Name of an equipment type as long as it isn’t already in use. 

Truck Count is an integer value defining the number of trucks for the specified equipment type.  For 

non-articulated equipment this value will usually be 2.  For articulated cars the value typically ranges 

from 3 to 11.  This value is used to determine how many possible locations are available for each 

component type. 

Description is optional.  It can be used to add additional information or descriptive information about 

the equipment type. 

Click Save to add the equipment type to your system.  Cancel closes the dialog without saving changes. 
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Adding Equipment 

Equipment must be added to the RIMS system so component application can be tracked.  Equipment 

can be added in the shop/field using Car Builder (purchase required) or it can be added from Car 

Manager.  To add new equipment, select ‘Add Equipment’ from the Equipment menu. 

ID consists of the car initial and car number.  This is sometimes referred to as the Car ID or ‘Road 

Number’.  There is no need to add a space between the initial and the number.  All padding/spacing will 

be handled automatically. 

Description is optional.  It allows you to enter additional information about this particular equipment. 

The ‘In For Repairs’ checkbox flags the new car as In For Repair.  You can use this field to filter your 

Equipment Search results to only show cars that are in for repair.  This will limit the search results to a 

more manageable number.  The default is checked. 

Select the Equipment Type from the dropdown.  To manage the list of available equipment types refer 

to the previous section on Managing Equipment Types.  The Type Description and Truck Count will be 

displayed for the selected equipment type to help you verify you have selected the correct equipment 

type. 

Click Save to add the equipment or Cancel to close the dialog without saving. 

 

In most cases it is necessary to add a list of equipment instead of adding them one at a time.  If you have 

a Comma Separated Values (CSV) file containing the required information you can import a list of 

equipment all at once.  The CSV file needs to contain at a minimum the car initial and number (as one 
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field or separate fields) and the equipment type (as defined in your Equipment Types list).  To add a list 

of equipment, select ‘Import Equipment’ from the Equipment menu. 

Click ‘Browse’ to select the CSV file you want to import.  The preview at the bottom shows the data you 

are about to import. 

If the car number and initial are contained in the same field, select that field in the first Equipment ID 

dropdown and leave the second dropdown unselected.  Otherwise select the car initial field in the first 

dropdown and the car number field in the second dropdown. 

Select the field that contains the equipment type. 

Click Import to add all equipment from the file, or Cancel to close the dialog without adding any 

equipment. 
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Editing Equipment 

If you have not already submitted any component applications you can edit the equipment ID from the 

equipment details area above the Component list.  If the user has appropriate permissions they can 

modify the equipment ID or change the In For Repair and Inactive properties. 

 

To edit the Equipment ID click in the box and make necessary changes. You can only change this if you 

have not already successfully associated a component.  Once you have associated one or more 

component(s) you must remove the component(s) before you can edit the equipment id. 
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New equipment and/or equipment that you will be working on in the near future should be marked as 

In For Repair.  Any equipment that you are finished working on can be set to not In For Repair by 

unchecking this box.  This allows you to filter your equipment search so only equipment that you are 

actively working on appears in the search results.   

When the Inactive property is checked, equipment will never show up in the search results list by 

default.  To be able to search for Inactive equipment you must turn on the Show Inactive option from 

the Equipment Menu.  This is useful to hide equipment you never plan to see again.  For example if the 

equipment is being re-stenciled it will be assigned a new equipment ID so you will need to create a new 

Equipment.  You can set the original equipment to Inactive so it won’t show up when you search. 

Click Save to save changes to the equipment.   

Click Cancel to discard changes. 

Click Submit to save changes and try to associate all components that are not already associated.  
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Deleting Equipment 
 

If you have equipment that was added in error you can delete it from the RIMS System if you have the 

appropriate permissions. 

 To remove an equipment simply click the red X in the top left corner of the Equipment Details area. 

 

 

You will be prompted to confirm you want to remove the equipment. 

 

 

If there are any components applied to the equipment you will not be able to remove the equipment 

until you have first removed all applied components. 
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Searching Equipment 

The Equipment tab allows you to search for equipment that you have already added via filters and 

search criteria.  Once the Equipment list is populated with the results, you can click on any of the 

equipments to show its details and associated components; you can right-click on an equipment in the 

list to print its details (also available in the ‘File’ menu), or to copy its Equipment ID to the clipboard. 

Filters 

 

The Errors checkbox will filter the Equipment list to show only equipment with Component Association 

errors.  For more information see the section on Association below. 

The Not Associated checkbox will filter the Equipment list to show only equipment with components 

that have been applied but not submitted to the AAR as a repair.  For more information see the section 

on Components below. 

The In For Repairs Only checkbox will filter the Equipment list to show only equipment that is in for 

repairs. 

 

Search Criteria 

In addition to filtering the equipment list you can also enter search criteria to limit the number of 

equipment that display in the list. 

The first and most common search criterion is the equipment ID.  

 

Entering any part of the equipment ID will limit the equipment in the list to only show equipment whose 

ID contains part or all of the text in the search box.  For example, you can enter the car initial to only 

show equipment with the same car initial.  You can also enter the entire equipment ID to find specific 

equipment.  The equipment list is updated as you type.  If the equipment list is empty no equipment 

matches your search criteria and/or filter. 

 You can see the total number of cars that match your search below the search results list. For more 

information see the section on Components. 

 



Revised 2013-12-1308 

©2013 Arkansas Industrial Computing 25 
 

In addition to searching with equipment ID, you can search a component ID (CID) matching one or more 

of the components applied to equipment by clicking the arrow inside the box where Equipment ID is 

located. This will expand and allows you to select Component ID.  

 

You can also filter your search by date range the equipment was added to the system. By clicking the 

arrow in the Date box this will allow you to filter by This Week, This Month, This Year, or by using a 

Custom date range. 

 

Select Custom and specify your beginning and ending dates to search by a specific date range the 

equipment was added to the system. 
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Advanced Search 

 

Car Manager’s Advanced Equipment Search feature allows users to customize searches beyond the 

standard search criteria to create targeted searches.  To access the Advanced Search window, click the 

‘>’ button beside the magnifying glass. 

 

To begin creating your advanced search, select a search field from the dropdown box and enter/select a 

value for the field; when appropriate, you may change the operator to return a range of results instead 

of only those that equal the criteria.  For example, the search below would return all components 

created AFTER the selected date; changing the operator to ‘<=’ would return components created 

BEFORE the selected date. 

 

Once your first condition is complete, click the green ‘+’ button on the left of the window if you want to 

add another condition to your search. 

Car Manager’s Advanced Search only searches certain fields by default; in order to 

specify a field that is not shown by default, check the ‘Show All Fields’ box in the 

bottom left corner of the pane.  Editing the fields shown by default requires altering your database 

entries for the element descriptions; for more information about this, contact your administrator or our 

support staff. 

When you have finished entering the desired search conditions, click Search.  Your results will display in 

the Components List just like a standard search. 
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Component Application 

One of the primary roles of Car Manager is in tracking and reporting component application.  

Components are tracked to equipment by the component ID assigned to each Component at the time of 

Component Registration (see https://www.railinc.com/rportal/cepm-project-overview for more 

information).   

Each equipment has a list of locations available for component application.  The possible locations are 

determined by the component type as well as the equipment type.  For example, an equipment type 

that has 2 trucks will have locations for 4 wheelsets, 4 side frames, and 2 bolsters. 

 

Component application can be entered manually using Car Manager by typing in the Component ID 

(CID) of the component you want to apply in the box next to the component type and location where 

you want to apply it.  For example, to apply a wheelset to location 3 you would simply enter the CID in 

the box next to wheelset location 3. 

https://www.railinc.com/rportal/cepm-project-overview
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Click Save to apply any changes. 

Click Cancel to undo changes. 

Once a component has been applied it must be removed if any changes are required.  To remove a 

component click the X to the right of the CID 

 

For more information on component application contact us about our other RIMS applications such as 

Car Builder and Truck Builder.  These applications help take the data collection process to the shop floor 

or field and greatly improve speed and reduce errors. 

 

  



Revised 2013-12-1308 

©2013 Arkansas Industrial Computing 29 
 

Association 

Once a component has been applied to an equipment it must be reported to Railinc.  This reporting 

process is referred to as Component Association.   

Click the Submit button to report any components that have not already been associated.  If there are 

any components with errors or warnings they will be reported as well.  In most cases you will wait to 

report the component applications until all components have been applied. 

When a component is submitted it is sent to the RIMS Service which verifies the required information 

has been entered and then forwards the information to Railinc using their repair Web Service.  Once a 

response has been received indicating if the association was successful the response is forwarded back 

to Car Manager where it will display the status as Success, Warning, or Error. 

 

A status of Success indicates the association was successfully reported. 

A status of WARNING indicates the association was successfully reported, but a problem occurred during 

the process.  Click the ‘WARNING’ link to display the warning message that was returned. 

A status of ERROR indicates the association was not reported.  Click the ‘ERROR’ link to display the error 

message that was returned. 

For help with warnings and errors refer to Appendix A- Frequently Asked Questions below. 
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Trucks 

Our Truck Builder application (a component of the Railcar Integrated Maintenance Suite – purchased 

separately) allows for tracking component application to a truck.  That truck can then be tracked and 

applied to an equipment which in turn applies all components of that truck to the equipment.  This 

allows the user to quickly and easily access the Component ID barcodes as the truck is assembled, 

instead of requiring them to crawl around the car or truck when the truck is applied to the car. 

The Trucks tab allows you to view, edit, and manage the component application for trucks that were 

entered from Truck Builder. 

For more information about Truck Builder, contact us.  
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Component Registration 

Overview 

One of the roles of Car Manager is to assist with Component Registration as required by the AAR’s 

Comprehensive Equipment Performance Monitoring (CEPM) program.  This program tracks the 

application of Wheelsets, Side Frames 1, Bolsters 1, and Couplers 1 to the equipment.  For more 

information about Component Registration refer to the CEPM Program Overview at 

https://www.railinc.com/rportal/cepm-project-overview  

 

Our Component Data Collector (CODeC) application (a component of the Railcar Integrated 

Maintenance Suite – purchased separately) allows for entering component element data required for 

component registration.  A user enters the component data and applies a Component ID barcode label 

before reporting the Registration to Railinc. 

For more information about CODeC, contact us. 

 

 

 

  

                                                           
1
 Required in 2013 

https://www.railinc.com/rportal/cepm-project-overview
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Searching Components 
The Components tab allows you to search for components that you have already added via filters and 

search criteria.  Once the Components list is populated with the results, you can click on any of the 

components to show its details. 

Filters 

 

The Errors checkbox will filter the Components list to show only equipment with Component 

Registration errors.  For more information see the section on Association below. 

The In For Repairs Only checkbox will filter the Equipment list to show only equipment that is in for 

repairs. 

 

Search Criteria 

In addition to filtering the components list you can also enter search criteria to limit the number of 

components that display in the list. 

The first and most common search criterion is the Component ID.  

 

Entering any part of the Component ID will limit the components in the list to only show components 

whose ID contains part or all of the text in the search box.  You can also enter the entire equipment ID to 

find a specific Component. 
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In addition to searching by Component ID, you can search for components by their associated 

Equipment ID by selecting Equipment ID from the dropdown next to the search bar.  

You can also filter your search by date range the component was added to the system. By clicking the 

arrow in the Date box this will allow you to filter by This Week, This Month, This Year, or by using a 

Custom date range. 

 

Select Custom and specify your beginning and ending dates to search by a specific date range the 

component was added to the system. 
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Advanced Search 

 

Car Manager’s Advanced Component Search feature allows users to customize searches beyond the 

standard search criteria to create targeted searches.  To access the Advanced Search window, click the 

‘>’ button next to the magnifying glass. 

 

To begin creating your advanced search, select a search field from the dropdown box and enter/select a 

value for the field; when appropriate, you may change the operator to return a range of results instead 

of only those that equal the criteria.  For example, the search below would return all components 

created AFTER the selected date; changing the operator to ‘<=’ would return components created 

BEFORE the selected date. 

 

Car Manager’s Advanced Search only searches certain fields by default; in order to 

specify a field that is not shown by default, check the ‘Show All Fields’ box in the 

bottom left corner of the pane.  Editing the fields shown by default requires altering your database 

entries for the element descriptions; for more information about this, contact your administrator or our 

support staff. 
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In order to search based on criteria that is specific to one type of component, such as a coupler’s cavity 

number, you must first select ‘ComponentTypeName’ and specify the type of component to which the 

criteria applies.  Once a component type is selected, click the green ‘+’ button on the left of the window 

to add another condition to your search.  Now, the Fields dropdown will include characteristics specific 

to the type of component selected in the first row. 

 

When you have finished entering the desired search conditions, click Search.  Your results will display in 

the Components List just like a standard search. 
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Managing Components 

Car Manager currently only allows you to view, modify, and register components that have already been 

added using the CODeC application.  Once you have located a component using the search criteria click 

on it to view the component data. 

If the user has the appropriate permissions you can modify any or all values except the Component ID; 

the Component ID can only be modified if the selected component has not been registered through 

Railinc.  If the selected component’s CID value can be modified, it will be displayed as a textbox instead 

of plain text in the top of the details pane. 

 

Click Save to apply your changes. 

Click Cancel to undo changes. 

Click the ‘>’ button next to Save to delete the selected component from the database; this can only be 

done if the component has not been registered or the registration has been removed. 
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Registration 
Once you have entered all required component data it must be reported to Railinc.  This reporting 

process is referred to as component Registration.   

Click the Register button to report the component Registration to Railinc. 

When a component is registered it is sent to the RIMS Service which verifies the required information 

has been entered and then forwards the information to Railinc using their registration Web Service.  

Once a response has been received by the RIMS Service it is forwarded back to Car Manager where it 

will display the status as Success or ERROR. 

  

A status of Success indicates the registration was successfully reported. 

A status of ERROR indicates the registration was not reported.  Click the ERROR link to display the error 

message that was returned. 

For help with warnings and errors refer to Appendix A- Frequently Asked Questions below. 

To remove a registration from the selected component, click the ‘>’ button next to Register in the 

bottom-right corner of the screen.  This must be done before you will be able to remove a component 

from your database. 
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Component Shipping 
 

 

Car Manager allows you to manage incoming and outgoing shipments, via the Manage Shipments 

window.  Shipping features include the ability to import and export shipment details, so if you work with 

another company that uses Car Manager, component shipments can be easily tracked and added to the 

database. 

The Inbound and Outbound handheld apps are offered as part of RIMS to handle shipments in the field.  

The Manage Shipments window in Car Manager is intended primarily for tracking and review. 

 

The Manage Shipments window can be accessed by 

selecting Manage Shipments from the Tools menu.  

 

 

 



Revised 2013-12-1308 

©2013 Arkansas Industrial Computing 39 
 

Shipment Info 
 
Once you have selected a shipment for review, the right pane of the Manage Shipments window will 

display the stored information about the selected shipment.  You can add Carriers by clicking on the 

green ‘+’ plus sign on the Shipment Info tab. 

 

Components 
 
The components tab displays the components on the selected shipment.   
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Import/Export 
 
The import and export features allow shipments to be accepted automatically via a shipment file. 

To export a shipment, select the shipment and click the ‘Export’ button. 

 

This will open a Save As window where a user can select the file name and save destination.  The 

exported shipment file will be an .xml file type. 

If you receive a shipment file with an incoming shipment, you can import the shipment information by 

clicking the Import button and selecting the incoming shipment file.  Imported shipments are defaulted 

to INBOUND shipment types.  Once the shipment has been imported, the components on the shipment 

are added to the RIMS database automatically.  

 

 

Manage Customers 
 
To add a customer and customer location to the 

RIMS shipping system, select ‘Manage Customers’ 

from the tools menu.   
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The Customer Info tab lets you set default information for customers as well as adding and deleting 

them. 

 

The Locations tab allows you to set shipping information for multiple locations on a single customer. 

 

Once you have finished entering customer information, click save.  The newly entered customer should 

now appear in the appropriate dropdown lists in Car Manager and the Inbound and Outbound handheld 

shipping applications.  
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Appendix A: Frequently Asked Questions (FAQ) 
 

Q. Why does Car Manager crash when trying to set the database connection information? 

A.  The most common cause is that the Windows user does not have permission to access the area of the Windows 

Registry where Car Manager saves some of its settings.  Contact us or a member of your IT department for 

assistance. 

 

Q. I receive the following warning when attempting to associate a component: “One or more Component Tag ID 

has not changed on the equipment unit.” 

A. This message is returned from Railinc’s web service.  It means that you have attempted to associate a 

component that has already been associated.  This is usually the result of clicking the Submit button multiple 

times. 

 

Q. I receive the following warning when attempting to associate a component: “The equipment unit is not found in 

Umler on the particular association date, so the component association request is recorded as received, but not 

applied.” 

A. This message is returned from Railinc’s web service.  It means that the equipment ID is invalid, or it cannot be 

found in Umler.  Verify the equipment ID is correct.  If it is incorrect you can edit the equipment ID and Submit 

again. 

 

Q.  I receive the following error(s) when attempting to associate a component:  “Failed to associate component to 

car…Component requested does not exist”. 

A. The component ID is incorrect or the component was not registered.  Verify the component ID has been entered 

correctly.  If the component ID is correct you will need to contact the company that you purchased the component 

from to verify the component was registered.   

 

Q.  I receive the following error when attempting to associate a component:  “Communications error”. 

A. This message indicates the RIMS Service could not connect to Railinc’s web service, or an error occurred when 

trying to send the report to Railinc.  Contact us or a member of your IT department for assistance. 
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Q. I am receiving a message that says “The ability to associate components to equipment is currently unavailable, 

but the connection will be retried again each time the Submit button is clicked”.  What does this mean? 

A. Component Association requires a connection to a computer running the RIMS Service application.  If Car 

Manager is unable to communicate with the RIMS Service application the associations cannot be reported to 

Railinc.  If the communications failure is temporary then you don’t have to do anything.  If you receive this 

message frequently you need to contact your IT department or our support team for assistance. Refer to the 

section on RIMS Service settings for more information. 

 

Q. I am receiving a message that says “The ability to register components is currently unavailable, but the 

connection will be retried again each time the Register button is clicked”.  What does this mean? 

A. Component Registration requires a connection to a computer running the RIMS Service application.  If Car 

Manager is unable to communicate with the RIMS Service application the component registration cannot be 

reported to Railinc.  If the communications failure is temporary then you don’t have to do anything.  If you receive 

this message frequently you need to contact your IT department or our support team for assistance. Refer to the 

section on RIMS Service settings for more information. 

 

Q. How can I view/retrieve the Car Manager log files? 

A. 

   

In the event that the Car Manager application does not function properly and you require technical 

support, you may be asked to submit the Car Manager Log File.  A copy of this log can be obtained by 

selecting Help->View Log File from the Car Manager menu.  This will open a .txt file that can be saved 

and attached to support emails.  



Revised 2013-12-1308 

©2013 Arkansas Industrial Computing 44 
 

Appendix B: License 

RAILCAR INTEGRATED MAINTENCANCE SUITE END USER LICENCSE AGREEMENT 

 

IMPORTANT NOTICE:  Read Before Installing or Using Software 

 

The following software products offered to you directly by Arkansas Industrial Computing (“AIC”) of 6100 
Getty Drive, Suite N, North Little Rock,  AR 72117 (voice 501-834-9540) is offered only for use in 
accordance with the terms and conditions of the RMS End User License Agreement below. 
 
BY INSTALLING OR USING ANY LICENSED SOFTWARE YOU WILL INDICATE THAT YOU HAVE 
READ, UNDERSTOOD, AND ACCEPT THESE TERMS AND CONDITIONS AND BECOME A PARTY 
TO THIS AGREEMENT.  IF YOU ARE UNABLE OR UNWILLING TO ENTER AND COMPLY WITH THIS 
AGREEMENT, DO NOT ATTEMPT TO INSTALL OR USE ANY LICENSED SOFTWARE.  INSTEAD, 
PROMPTLY RETURN ANY MATERIALS THAT WERE PROVIDED TO YOU.  CONTACT AIC IF YOU 
WISH TO DISCUSS THE AGREEMENT BELOW, BEFORE YOU ATTEMPT TO INSTALL OR USE ANY 
PRODUCT. 
 
RMS END USER LICENSE AGREEMENT 
 
LICENSE:  Subject to the terms and conditions of this Agreement, AIC hereby grants to you a non-
exclusive, non-transferable license to use the Licensed Software on one computer.  This includes 
reproducing the Licensed Software, but only as reasonably required to ensure appropriate back-up 
practices are followed.  All copies must bear all copyright and other proprietary rights notices which 
appear on the Licensed Software as originally provided by AIC.  Subject to the license expressly granted 
above, you obtain no right, title, interest or other license in or to any Product, including but not limited to 
any copyright, patent, trade secret, trademark, or other proprietary rights therein.  All whole and partial 
copies of the Licensed Software remain the property of AIC and will be considered part of the Licensed 
Software for the purpose of this Agreement.   
 
Unless expressly permitted by this Agreement, or otherwise by applicable law or by AIC in writing, you 
shall not: (i) use, reproduce, modify, adapt, translate, update or transmit any Licensed Software, in whole 
or in part; (ii) rent, lease, license, transfer, or otherwise provide access to any Licensed Software; (iii) 
alter, remove, or cover trademarks or proprietary notices in or on any Licensed Software; (iv) export any 
Licensed Software from the country in which it was provided to you by AIC; (v) decompile, disassemble, 
decrypt, extract or otherwise attempt or assist others to reverse engineer any Licensed Software, except 
as necessary, when permitted by an applicable law, to correct defects or achieve interoperability with 
complimentary programs, for your purposes only, but only if AIC has refused to provide the necessary 
information or assistance.  Unless AIC has provided you with express written consent, the Licensed 
Software may not be used in any application in which the failure of the Licensed Software could lead 
directly to death, personal injury, or severe physical or property damage (collectively, “High-Risk 
Activities”).  AIC EXPRESSLY DISCLAIMS ANY EXPRESS OR IMPLIED WARRANTY OR CONDITION 
OF FITNESS FOR HIGH-RISK ACTIVITIES. 
 
WARRANTY:  AIC cannot warrant that any Licensed Software will function in accordance with related 
documentation in every combination of hardware platform, software environment, and Licensed Software 
configuration.   
 
LIMITATIONS:  EXCEPT AS EXPRESSLY WARRANTED ABOVE, THE LICENSED SOFTWARE AND 
ANY ASSOCIATED AIC MEDIA ARE PROVIDED “AS IS” WITHOUT OTHER WARRANTIES OR 
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CONDITIONS OF ANY KIND, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES AND 
CONDITIONS OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-
INFRINGEMENT. YOU ASSUME THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF 
THE LICENSED SOFTWARE.  NOTHING STATED IN THIS AGREEMENT WILL IMPLY THAT THE 
OPERATION OF ANY LICENSED SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE OR 
THAT ERRORS WILL BE CORRECTED.  OTHER WRITTEN OR ORAL STATEMENTS BY AIC, ITS 
REPRESENTATIVES OR OTHERS DO NOT CONSTITUTE WARRANTIES OF AIC. 
 
IN NO EVENT WILL AIC (OR IT’S OFFICERS, EMPLOYEES, AGENTS, SUPPLIERS, DISTRIBUTORS, 
OR LICENSORS – COLLECTIVELY “ITS REPRESENTATIVES”) BE LIABLE TO YOU FOR ANY 
INDIRECT, INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAMAGES WHATSOEVER, INCLUDING 
BUT NOT LIMITED TO LOST REVENUE, LOST OR DAMAGED DATA OR OTHER COMMERCIAL OR 
ECONOMIC LOSS, ARISING OUT OF OR RELATING TO ANY BREACH OF THIS AGREEMENT, ANY 
USE OR INABILITY TO USE THE LICENSED SOFTWARE, OR ANY CLAIM MADE BY A THIRD 
PARTY, EVEN IF AIC OR IT’S REPRESENTATIVES HAVE BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGE OR CLAIM. 
 
IN NO EVENT WILL THE AGGREGATE LIABILITY OF AIC AND IT’S REPRESENTATIVES FOR ANY 
DAMAGES OR CLAIMS ARISING OUT OF OR RELATING TO THIS AGREEMENT OR ANY LICENSED 
SOFTWARE, WHETHER IN CONTRACT, TORT, OR OTHERWISE, EXCEED THE LICENSE FEES 
YOU PAID FOR THE USE OF THE LICENSED SOFTWARE UNDER THIS AGREEMENT.  AIC’S AND 
IT’S REPRESENTATIVE’S LIMITATION OF LIABILITY IS CUMULATIVE WITH ALL OF AIC’S AND IT’S 
REPRESENTATIVE’S PAYMENTS IN SATISFACTION OF THEIR LIABILITIES BEING AGGREGATED 
TO DETERMINE SATISFACTION OF THE LIMIT. 
 
These limitations shall apply whether or not the alleged breach is a fundamental breach of contract.  
Some jurisdictions curtail limitations of liability for incidental or consequential damages, and/or limitations 
of implied warranties.  Therefore, to the extent prohibited by applicable law, the above limitations may not 
apply to you. 
 
TERM:  This Agreement commences upon your acceptance (as described above) and will end when 
terminated.  You may terminate this Agreement at any time.  It will be deemed to terminate immediately if 
you fail to comply with any material term herein.  Upon termination, your license rights end and you shall 
immediately destroy all whole or partial copies of all Licensed Software in your possession or control. 
 
GENERAL:  This Agreement is governed by and will be construed in accordance with the laws in force in 
the State of Arkansas, United States of America without regard to the conflict of laws provisions therein.  
The parties expressly disclaim the provisions of the United Nations Convention on Contracts for the 
International Sale of Goods.  This Agreement constitutes the entire agreement between you and AIC 
pertaining to the Licensed Software and any associated AIC media, and supersedes all prior or 
contemporaneous agreements, understandings, negotiations, and discussions, whether oral or written.  
No amendment or waiver of any term of this Agreement will be binding unless executed in writing by the 
parties.  Subject to the export restrictions provided above, you are entitled to assign this Agreement to a 
third party who has provided AIC with prior written acknowledgement of their acceptance of the terms and 
conditions herein.  In such a case you will transfer all copies of the Licensed Software and any associated 
media to the assignee.  The provisions of this Agreement will ensure to the benefit of and will be binding 
upon the parties and their respective successors and permitted assigns.  If any provision of this 
Agreement is held by a court of competent jurisdiction to be illegal, invalid, or unenforceable, the 
remaining provisions shall remain in full force and effect.  
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Appendix C: Contact Information 
 

AIC Rail 
6100 Getty Drive  
Suite N 
Sherwood, AR 72117 
 

Online Support 
Visit our website at www.aicrail.com for 24/7 technical information and available downloads. 
Email us at support@wheelshopautomation.com 
 
Phone Support (Existing support contract or credit card required) 
Call 1-501-834-9540 or 1-877-834-9540 (toll free) 

http://www.aicrail.com/

